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Introduction

You can use LibreOffice without requiring a pointing device, such as a mouse or touchpad, by
using its built-in keyboard shortcuts.

LibreOffice has a general set of keyboard shortcuts, available in all components, and a component-
specific set directly related to the work of that component. This appendix lists the default set for
Writer. For general shortcuts, see Appendix A of the Getting Started guide.

For help with LibreOffice’s keyboard shortcuts, or using LibreOffice with a keyboard only, search
the LibreOffice Help using the “shortcut” or “accessibility” keywords.

In addition to using the built-in keyboard shortcuts listed in this Appendix, you can define your own.
See Chapter 16, Customizing Writer, for instructions.

Some of the shortcuts listed here may not work if your operating system uses the
same shortcuts for other tasks.

Note To get around this problem, assign different keys to these shortcuts by reconfiguring
either LibreOffice (see Chapter 16) or your operating system (see system
documentation).

Tip for Macintosh users

Some keystrokes are different on a Mac from those used in Windows and Linux. The following
table gives some common substitutions for the instructions in this book. For a more detailed list,
see the application Help.

Windows or Linux Mac equivalent Effect

Right-click Control+click Opens context menu

Ctrl (Control) # (Command) Used with other keys

F5 Shift+3+F5 Opens the Navigator

F11 #+T Opens theStyles and Formatting window

Opening menus and menu items

Shortcut Keys Result

Opens a menu where <?> is the underlined character of the menu you want
to open. For example, Alt+F opens the menu File.

With the menu open, you will again find underlined characters. You can
access these menu items directly by simply pressing the underlined
character key. Where two menu items have the same underlined character,
press the character key again to move to the next item.

Example: to access the Printer Settings item of the File menu after opening
it, press R twice to move from the initial Digital Signatures selection to
Printer Settings.

Exception: Language in the Tools menu has no underlined characters.

Alt+<?>
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Shortcut Keys Result

Repeatedly pressing F6 switches the focus and circles through the following

objects:
£6 * Menu bar
* Every toolbar from top to bottom and from left to right
* Every free window from left to right
¢ Document
Shift+F6 Switches through objects in the opposite direction.
Ctrl+F6 Switches the focus to the document.
F10 or Alt Switches to the Menu bar and back.
Esc Closes an open menu.

Accessing a menu command

Press Alt or F6 or F10 to select the first item on the menu bar (the File menu). With the
right-arrow, the next menu to the right is selected; with the left-arrow, the previous menu. The
Home and End keys select the first and the last item on the Menu bar.

The down-arrow opens a selected menu. An additional down-arrow and up-arrow moves the
selection through the menu commands. The right-arrow opens any existing submenus.

Press Enter to execute the selected menu command.

Executing a toolbar command

Press F6 repeatedly until the first icon on the toolbar is selected. Use the right and left arrows to
select an icon on a horizontal toolbar. Similarly, use the up and down arrows to select an icon on a
vertical toolbar. The Home key selects the first icon on a toolbar and the End key, the last.

Press Enter to execute the selected icon. If the selected icon normally demands a consecutive
mouse action, such as inserting a rectangle, then pressing the Enter key is not sufficient: in these
cases press Ctrl+Enter.

* Press Ctrl+Enter on an icon for creating a draw object. A draw object will be placed into the
middle of the view, with a predefined size.

* Press Ctrl+Enter on the Selection tool to select the first draw object in the document. If you
want to edit, size, or move the selected draw object, first use Ctrl+F6 to move the focus into
the document.

If a toolbar is longer than can be displayed on screen, it shows an icon at the right or lower edge.
Select the toolbar and press PageUp or PageDown to display the remaining icons.

Navigating and selecting with the keyboard

You can navigate through a document and make selections with the keyboard.
* To move the cursor, press the key or key combination given in the following table.

* To select the characters under the moving cursor, additionally hold down the Shift key when
you move the cursor.

Navigating and selecting with the keyboard 5



Key Function Plus Ctrl key

Right, left arrow Moves the cursor one character to Moves the cursor one word to the left

keys the left or to the right. or to the right.

Up, down arrow Moves the cursor up or down one (Ctrl+Alt) Moves the current

keys line. paragraph up or down.

Home Moves the cursor to the beginning of Moves the cursor to the beginning of
the current line. the document.

End Moves the cursor to the end of the Moves the cursor to the end of the
current line. document.

PgUp Scrolls up one page. Moves the cursor to the header.

PgDn Scroll down one page. Moves the cursor to the footer.

Controlling dialogs

When you open any dialog, one element (such as a button, an option field, an entry in a list box, or
a checkbox) is highlighted or indicated by a dotted box around the field or button name. This
element is said to have the focus on it.

Shortcut Keys Result

Enter Activates the selected button. In most cases where no button is
selected, Enter is equivalent to clicking OK.

Closes the dialog without saving any changes made while it was
Esc open. In most cases, Esc is equivalent to clicking Cancel. When an
open drop-down list is selected, Esc closes the list.

Spacebar Toggles a checkbox on or off.

Moves the focus up and down a list. Increases or decreases the

Up, down arrow keys value of a variable. Moves the focus vertically within a section of a
dialog.

Right, left arrow keys Moves the focus horizontally within a section of a dialog.

Tab Advances the focus to the next section or element of a dialog.

Shift+Tab Returns the focus to the previous section or element in a dialog.

Alt+Down-arrow Shows items in a drop-down list.

Macros
Shortcut Keys Result
Ctrl+* (multiplication sign: Runs a macro field.

on number pad only)

Shift+Ctrl+Q Stops a running macro.
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Shortcut keys for controlling documents and windows

Shortcut Keys Effect

Ctrl+O Opens a document.

Ctrl+S Saves the current document.

Ctrl+N Creates a new document.

Ctrl+Shift+N Opens Templates and Documents dialog.

Ctrl+P Opens the Print dialog.

Ctrl+F Activates the Find toolbar.

Ctrl+H Opens the Find & Replace dialog.

Ctrl+Shift+F Searches for the last entered search term.

CtrlI+Shift+J Toggles the view between full-screen mode and normal mode.

Ctrl+Shift+R Redraws the document view.

CtrI+Shift+l Enables or disables the selection cursor in read-only text.

F1 Starts the LibreOffice Help.
In the LibreOffice Help: jumps to main help page.

Shift+F1 Opens Context Help.

Shift+F2 Turns on Extended Tips for the currently selected command, icon or
control.

F6 Sets focus in next subwindow (for example, document/data source
view).

Shift+F6 Sets focus in previous subwindow.

F10 Activates the first menu (File menu).

Shift+F10 Opens the context menu.

Ctrl+F4 or Alt+F4

Closes the current document (closes LibreOffice when the last open
document is closed).

Ctrl+Q

Exits application.

Function keys for Writer

Shortcut keys

Effect

F1

Opens Writer Help at the Home page. Pressing F1 again opens the
home page of the active tab.

Function keys for Writer



Shortcut keys

Effect

Shift+F1 Enables the extended help tips under the mouse pointer until the next
click.

F2 Opens or closes the Formula Bar.

Ctrl+F2 Opens the Fields dialog.

Shift+F2 Displays tips for the currently selected command, icon, or control.

F3 Inserts the AutoText entry corresponding to the typed shortcut.

Ctrl+F3 Opens the AutoText dialog, where you can edit an AutoText entry or
create a new entry from the selected text.

F4 Opens or closes the View Data Sources window.

Shift+F4 Selects the next frame.

F5 Opens or closes the Navigator.

CtrlI+Shift+F5 Opens the Navigator with cursor in page number field.

F7 Starts the spelling and grammar checker.

Ctrl+F7 Opens the Thesaurus.

F8 Turns Extension Selection mode on or off.

Ctrl+F8 Turns field shadings on or off.

Shift+F8 Turns Multiple Selection mode on or off.

Ctrl+Shift+F8 Turns Block Selection mode on or off.

F9 Updates fields.

Ctrl+F9 Shows or hides field names.

Shift+F9 Calculates Table.

CtrlI+Shift+F9 Opens a dialog for editing input fields and lists.

F10 See “Opening menus and menu items* on page 4 for details.

Ctrl+F10 Displays or hides non-printing characters.

F11 Opens or closes the Styles and Formatting window.

Shift+F11 Creates a new style from a selection.

Ctrl+Shift+F11 Updates a style.

F12 Turns paragraph numbering on or off.

Ctrl+F12 Inserts or edits a table.

Shift+F12 Turns bullets on or off.

Keyboard Shortcuts



Shortcut keys

Effect

Ctrl+Shift+F12

Turns numbering/bullets off.

Shortcut keys for Writer

Shortcut Keys Effect

Ctri+A Selects all content in a document, unless the cursor is in a table (see
“Shortcut keys for tables” on page 11).

Ctri+D Double underlines selected text or text typed afterward. Press again to
turn off.

Ctrl+E Centers the paragraph.

Ctri+F Opens the Find toolbar.

Ctri+H Opens the Find and Replace dialog.

Ctrl+J Justifies the paragraph.

Ctri+L Aligns the paragraph to the left.

Ctrl+R Align the paragraph to the right.

Ctrl+M Removes direct formatting from the selected text or objects (as in
Format > Clear Direct Formatting).

Ctri+[ Decreases the size of the selected text.

Ctrl+] Increases the size of the selected text.

Ctrl+Shift+B Subscripts selected text or text typed afterward. Press again to turn off.

Ctrl+Shift+P SfoJperscripts selected text or text typed afterward. Press again to turn
off.

Ctrl+y Redoes last action.

Ctrl+Plus Key(+) Calculates the selected text and copies the result to the clipboard.

Ctrl+Hyphen(-)

Inserts a conditional hyphen.

Ctrl+Shift+Hyphen (=)

Inserts a non-breaking hyphen (not used for hyphenation).

Ctrl+Shift+X Stops applying direct character formats whilst typing, from the cursor
point onward.

Ctrl+/ (slash) Inserts a no-width optional line break.

CtrlI+Shift+Space Inserts a non-breaking space (not used for hyphenation and not
expanded if text is justified).

Shift+Enter Inserts a line break without paragraph change.

Shortcut keys for Writer



Shortcut Keys

Effect

Ctrl+Enter Inserts a page break.

Ctrl+Shift+Enter Inserts a column break in multi-column texts.
Alt+Enter Inserts a new paragraph without numbering.
Alt+Enter Inserts a new paragraph directly before or after a section or a table.
Arrow Left Moves cursor to left.

Shift+Arrow Left Moves cursor with selection to the left.
Ctrl+Arrow Left Goes to beginning of word.

Ctrl+Shift+Arrow Left Selects to the left word by word.

Arrow Right Moves cursor to right.

Shift+Arrow Right Moves cursor with selection to the right.
CtrI+Arrow Right Goes to start of next word.

CtrI+Shift+Arrow Right Selects to the right word by word.

Arrow Up Moves up one line.

Shift+Arrow Up Selects lines in an upwards direction.

Arrow Down Moves cursor down one line.

Shift+Arrow Down

Selects lines in a downward direction.

Home Goes to beginning of line.
Shift+Home Goes and selects to the beginning of a line.
End Goes to end of line.
Shift+End Goes and selects to end of line.
Ctrl+Home Goes to start of document.
Ctrl+Shift+Home Goes and selects text to start of document.
Ctrl+End Goes to end of document.
Ctrl+Shift+End Goes and selects text to end of document.
Ctrl+PageUp Switches cursor between text and header.
Ctrl+PageDown Switches cursor between text and footer.
Insert Turns Insert mode on or off.
PageUp Moves up one screen page.
Shift+PageUp Moves up one screen page with selection.
PageDown Moves down one screen page.
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Shortcut Keys Effect

Shift+PageDown Moves down one screen page with selection.

Ctrl+Del Deletes text to end of word.

Ctrl+Backspace Deletes text to beginning of word.

Ctrli+Shift+Del Deletes text to end of sentence.

CtrlI+Shift+Backspace Deletes text to beginning of sentence.

Ctrl+Tab Uses next suggestion with automatic word completion.
Ctrl+Shift+Tab Use previous suggestion with automatic word completion.

Alt+W In the spelling checker dialog: Calls back the original unknown word

into the text box.

Ctrl+double-click or
Ctrl+Shift+F10

Docks or un-docks the Navigator, Styles and Formatting window, or
other windows.

Shortcut keys for tables

Shortcut Keys

Effect

CtrlI+A

If the active cell is empty, Ctrl+A selects the whole table; otherwise, it
selects the contents of the active cell. Press Ctrl+A a second time to
select the entire table.

Ctrl+Home

If the active cell is empty, Ctrl+Home moves the cursor to the
beginning of the table. Press Ctrl+Home again to move the cursor to
the beginning of document.

If the active cell is not empty, Ctrl+Home moves the cursor to the
beginning of the active cell. A second press of Ctrl+Home moves the
cursor to the beginning of the current table. A third press moves the
cursor to the beginning of the document.

Ctrl+End

If the active cell is empty, Ctrl+End moves the cursor to the end of the
table. Press Ctrl+End again to move the cursor to the end of
document.

If the active cell is not empty, Ctrl+End moves the cursor to the end of
the active cell. A second press of Ctrl+End moves the cursor to the
end of the current table. A third press moves the cursor to the end of
the document.

Ctrl+Tab

Inserts a tab stop (only in tables). Depending on the Window Manager
in use, Alt+Tab may be used instead.

Ctrl+Shift+Arrow Up

Jumps to start of table.

Ctrl+Shift+Arrow Down

Jumps to end of table.

Alt+Arrow keys

Increases or decreases the size of the column or row on the right or
bottom cell edge.

Shortcut keys for tables

11



Shortcut Keys

Effect

Alt+Shift+Arrow keys

Increases or decreases the size of the column or row on the left or top
cell edge.

CtrI+Alt+Shift+Arrow keys

Like Alt, but modifies only the active cell.

Alt+insert

Provides 3 seconds in Insert mode, during which time pressing an
arrow key inserts a row or column, or Ctrl+Arrow Key inserts a cell.

Alt+Del

Provides 3 seconds in Delete mode, during which time pressing an
arrow key deletes a row or column, or Ctrl+Arrow Key merges the
active cell with the neighboring cell.

Ctrl+Shift+T

Removes cell protection from all selected tables. If no table is
selected, then cell protection is removed from all of the tables in the
document.

Ctrl+Shift+Del

If nothing is selected, the contents of the next cell are deleted. If cells
are selected, the whole row(s) of the selection are deleted. If all rows
are selected completely or partially, the entire table is deleted.

Shortcut keys for paragraphs and heading levels

Shortcut Keys Effect

Ctrl+0 (zero) Applies Text Body paragraph style.

Ctri+1 Applies Heading 1 paragraph style.

Ctrl+2 Applies Heading 2 paragraph style.

Ctrl+3 Applies Heading 3 paragraph style.

Ctrl+4 Applies Heading 4 paragraph style.

Ctrl+5 Applies Heading 5 paragraph style.

Ctrl+Alt+Up Arrow Moves the active paragraph or selected paragraphs up one

or Ctrl+Up Arrow

paragraph.

Ctrl+Alt+Down Arrow or

Moves the active paragraph or selected paragraphs down one

Ctrl+Down Arrow paragraph.

Tab When the cursor is at the beginning of the heading text, moves a
heading in format Heading X (X = 1-9) down one level in the outline.
Does not affect the applied paragraph style.

Shift+Tab When the cursor is at the beginning of the heading text, moves a
heading in format Heading X (X = 2—-10) up one level in the outline.
Does not affect the applied paragraph style.

Ctrl+Tab At the start of a heading: Inserts a tab stop. Depending on the Window
Manager in use, Alt+Tab may be used instead.
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Shortcut keys for moving and resizing frames, graphics, and

objects
Shortcut Keys Effect
Esc Cursor is inside a text frame and no text is selected: Esc selects the
text frame.
Text frame is selected: Esc clears the cursor from the text frame.
F2 or Enter If a text frame is selected: positions the cursor to the end of the text in

or any key that produces a
character on screen

the text frame. If you press any key that produces a character on
screen, and the document is in edit mode, the character is appended
to the text.

Alt+tArrow Keys Moves the selected object.

Alt+Ctrl+Arrow Keys Resizes an object by moving the lower right corner.
Alt+Ctrl+Shift+ Resizes an object by moving the top left corner.
Arrow Keys

Ctrl+Tab Selects the anchor of an object (in Edit Points mode).

Shortcut keys in the Gallery

Shortcut keys  Result

Tab Moves between areas.

Shift+Tab Moves between areas (backwards)

Shortcut keys in the New Theme area of the Gallery

Shortcut keys  Result

Up Arrow Moves the selection up.

Down Arrow Moves the selection down.
Ctrl+Enter Opens the Properties dialog.
Shift+F10 Opens a context menu.

Ctrl+U Refreshes the selected theme.
Ctri+R Opens the Enter Title dialog.
Ctrl+D Deletes the selected theme.
Insert Inserts a new theme.

Shortcut keys in the New Theme area of the Gallery
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Shortcut keys in the Gallery preview area

Shortcut keys Result

Home Jumps to the first entry.

End Jumps to the last entry.

Left Arrow Selects the next Gallery element on the left.

Right Arrow Selects the next Gallery element on the right.

Up Arrow Selects the next Gallery element above.

Down Arrow Selects the next Gallery element below.

Page Up Scroll up one screen.

Page Down Scroll down one screen.

Ctri+Shift+insert Inserts the selected object as a linked object into the current document.
Ctri+l Inserts a copy of the selected object into the current document.
Ctri+T Opens the Enter Title dialog.

Ctrl+P Switches between themes view and object view.

Spacebar Switches between themes view and object view.

Enter Switches between themes view and object view.

Step backward (only

in object view)

Switches back to main overview.

Selecting rows and columns in a database table (opened by

F4)
Shortcut keys Result
Spacebar Toggles row selection, except when the row is in edit mode.
Ctrl+Spacebar Toggles row selection.
Shift+Spacebar Selects the current column.

Ctrl+Page Up

Moves pointer to the first row.

Ctrl+Page Down

Moves pointer to the last row.
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Shortcut keys for drawing objects

Shortcut keys Result

Select the toolbar with F6. Use the
Down Arrow and Right Arrow to select
the desired toolbar icon and press

Inserts a Drawing Object.

Ctrl+Enter.

Select the document with Ctr/+F6 and Selects a Drawing Object.

press Tab.

Tab Selects the next Drawing Object.
Shift+Tab Selects the previous Drawing Object.
Ctrl+Home Selects the first Drawing Object.
Ctrl+End Selects the last Drawing Obiject.

Esc Ends Drawing Object selection.

Esc (in Handle Selection Mode)

Exit Handle Selection Mode and return to Object
Selection Mode.

Up/Down/Left/Right Arrow

Move the selected point (the snap-to-grid functions are
temporarily disabled, but end points still snap to each
other).

Alt+Up/Down/Left/Right Arrow

Moves the selected Drawing Object one pixel (in
Selection Mode).

Re-sizes a Drawing Object (in Handle Selection Mode).
Rotates a Drawing Object (in Rotation Mode).
Opens the properties dialog for a Drawing Obiject.

Activates the Point Selection mode for the selected
drawing object.

Spacebar Select a point of a drawing object (in Point Selection
mode) / Cancel selection.
The selected point blinks once per second.
Shift+Spacebar Select an additional point in Point Selection mode.
Ctrl+Tab Select the next point of the drawing object (Point
Selection mode).
In Rotation mode, the center of rotation can also be
selected.
CtrlI+Shift+Tab Select the previous point of the drawing object (Point
Selection mode).
Ctrl+Enter A new drawing object with default size is placed in the

center of the current view.

Ctrl+Enter at the Selection icon

Activates the first drawing object in the document.

Shortcut keys for drawing objects
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Shortcut keys

Result

Esc

Leave the Point Selection mode. The drawing object is
selected afterwards.

Edit a point of a drawing object (Point Edit mode).

Any text or numerical key

If a drawing object is selected, switches to edit mode and
places the cursor at the end of the text in the drawing
object. A printable character is inserted.

Alt key while creating or scaling a
graphic object

The position of the object's center is fixed.

Shift key while creating or scaling a
graphic object

The ratio of the object's width to height is fixed.

16

Keyboard Shortcuts



	Copyright
	Contributors
	Feedback
	Acknowledgments
	Publication date and software version

	Introduction
	Tip for Macintosh users

	Opening menus and menu items
	Accessing a menu command
	Executing a toolbar command

	Navigating and selecting with the keyboard
	Controlling dialogs
	Macros
	Shortcut keys for controlling documents and windows
	Function keys for Writer
	Shortcut keys for Writer
	Shortcut keys for tables
	Shortcut keys for paragraphs and heading levels
	Shortcut keys for moving and resizing frames, graphics, and objects
	Shortcut keys in the Gallery
	Shortcut keys in the New Theme area of the Gallery
	Shortcut keys in the Gallery preview area
	Selecting rows and columns in a database table (opened by F4)
	Shortcut keys for drawing objects

